MicroStation V8i Introduction to 3D (SELECTseries 3)

Bentley Institute Course Guide
Trademark Notice

Bentley and the "B" Bentley logo are either registered or unregistered trademarks or service marks of Bentley Systems, Incorporated. All other marks are the property of their respective owners.

AccuDraw, MDL, MicroStation, and SmartLine are registered trademarks; PopSet and Raster Manager are trademarks.

AutoCAD is a registered trademark of Autodesk, Inc.

Copyright Notice

Copyright ©2012, Bentley Systems, Incorporated. All Rights Reserved.
# Table of Contents

## Course Overview
- Course Description ........................................... 7
- Prerequisites .................................................. 7
- Course Objectives .............................................. 7
- Modules Included ............................................... 8

## Transitioning to 3D
- Module Overview ............................................... 9
- Module Prerequisites ........................................... 9
- Module Objectives .............................................. 9
- Introductory Knowledge
  - Questions .................................................. 10
  - Answers ................................................... 10
- 2D Construction Drawings .................................... 11

## 3D View Controls
- Module Overview ............................................... 15
- Module Prerequisites ........................................... 15
- Module Objectives .............................................. 15
- Introductory Knowledge
  - Questions .................................................. 16
  - Answers ................................................... 16
- View Rotation .................................................. 16
  - The Rotate View tool ..................................... 17
  - Rotating to a standard view ............................... 20
  - Rotating a view using the mouse ......................... 21
- Fitting 3D Views ............................................... 23
- Clipping Planes ............................................... 24
- Clip Volumes ................................................... 24
  - Clip Volume options ...................................... 28
  - Section Clip tools ......................................... 29
  - Clip Volumes and View Attributes ....................... 31
  - Clip Volume settings and Display Style ............... 33
  - Applying a clip volume .................................... 33
  - Manipulating a clip volume from a second view ........ 40
  - Saving clip volumes ....................................... 41
Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with multiple clip volumes</td>
<td>41</td>
</tr>
<tr>
<td>Using a clip mask</td>
<td>42</td>
</tr>
<tr>
<td>Display Styles Dialog</td>
<td>44</td>
</tr>
<tr>
<td>Modifying Display Styles</td>
<td>45</td>
</tr>
<tr>
<td>Review effects of the Display Style dialog tools</td>
<td>46</td>
</tr>
<tr>
<td>Perspective</td>
<td>49</td>
</tr>
<tr>
<td>Saved Views</td>
<td>50</td>
</tr>
<tr>
<td>The Saved Views dialog</td>
<td>50</td>
</tr>
<tr>
<td>Module Assessment</td>
<td>53</td>
</tr>
<tr>
<td><strong>AccuDraw in 3D</strong></td>
<td>55</td>
</tr>
<tr>
<td>Module Overview</td>
<td>55</td>
</tr>
<tr>
<td>Module Prerequisites</td>
<td>55</td>
</tr>
<tr>
<td>Module Objectives</td>
<td>55</td>
</tr>
<tr>
<td>The AccuDraw Drawing Plane</td>
<td>56</td>
</tr>
<tr>
<td>Drawing in 3D</td>
<td>60</td>
</tr>
<tr>
<td>3D Element Placement</td>
<td>63</td>
</tr>
<tr>
<td>Using AccuDraw’s rotated drawing plane</td>
<td>70</td>
</tr>
<tr>
<td>Non-orthogonal rotation</td>
<td>73</td>
</tr>
<tr>
<td>Locating elements relative to others</td>
<td>81</td>
</tr>
<tr>
<td>Using Auxiliary Coordinate Tools</td>
<td>83</td>
</tr>
<tr>
<td>Auxiliary Coordinates dialog tool features</td>
<td>88</td>
</tr>
<tr>
<td>Important notes on the ACS system</td>
<td>89</td>
</tr>
<tr>
<td>ACS and the depth Lock</td>
<td>90</td>
</tr>
<tr>
<td>ACS and depth lock questions and answers</td>
<td>92</td>
</tr>
<tr>
<td>AccuDraw shortcuts for ACS</td>
<td>94</td>
</tr>
<tr>
<td>Define an ACS aligned with a reference file</td>
<td>96</td>
</tr>
<tr>
<td>ACS interaction with AccuDraw</td>
<td>97</td>
</tr>
<tr>
<td>Separate ACS per View</td>
<td>97</td>
</tr>
<tr>
<td>Turn the ACS Plane on or off</td>
<td>98</td>
</tr>
<tr>
<td>Module Assessment</td>
<td>103</td>
</tr>
<tr>
<td><strong>Basic Solids</strong></td>
<td>105</td>
</tr>
<tr>
<td>Module Overview</td>
<td>105</td>
</tr>
<tr>
<td>Module Prerequisites</td>
<td>105</td>
</tr>
<tr>
<td>Module Objectives</td>
<td>105</td>
</tr>
<tr>
<td>3D Workflows</td>
<td>106</td>
</tr>
<tr>
<td>Solids Modeling task</td>
<td>106</td>
</tr>
<tr>
<td>3D Primitive Solids</td>
<td>107</td>
</tr>
<tr>
<td>Place Slab</td>
<td>108</td>
</tr>
<tr>
<td>Place Sphere</td>
<td>108</td>
</tr>
<tr>
<td>Place Cylinder</td>
<td>109</td>
</tr>
<tr>
<td>Place Cone</td>
<td>109</td>
</tr>
<tr>
<td>Place Torus</td>
<td>110</td>
</tr>
<tr>
<td>Place Wedge</td>
<td>110</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Place Pyramid Solid</td>
<td>111</td>
</tr>
<tr>
<td>Elliptical Cone Solid</td>
<td>112</td>
</tr>
<tr>
<td>Ellipsoid Solid</td>
<td>113</td>
</tr>
<tr>
<td>Regular Polyhedron</td>
<td>114</td>
</tr>
<tr>
<td>Create Solids Toolbox</td>
<td>115</td>
</tr>
<tr>
<td>Solid by Extrusion</td>
<td>116</td>
</tr>
<tr>
<td>Solid By Revolution</td>
<td>120</td>
</tr>
<tr>
<td>Solid By Thicken Surface</td>
<td>123</td>
</tr>
<tr>
<td>Linear Solid</td>
<td>124</td>
</tr>
<tr>
<td>Challenge Exercises</td>
<td>126</td>
</tr>
<tr>
<td>3D Modeling Process</td>
<td>127</td>
</tr>
<tr>
<td>Modifying Solids</td>
<td>128</td>
</tr>
<tr>
<td>Uniting Solids</td>
<td>128</td>
</tr>
<tr>
<td>Intersect Solids</td>
<td>128</td>
</tr>
<tr>
<td>Subtract Solids</td>
<td>130</td>
</tr>
<tr>
<td>Cut Solids By Curves</td>
<td>131</td>
</tr>
<tr>
<td>Module Assessment</td>
<td>133</td>
</tr>
<tr>
<td>Conceptual Modeling</td>
<td>135</td>
</tr>
<tr>
<td>Module Overview</td>
<td>135</td>
</tr>
<tr>
<td>Module Prerequisites</td>
<td>135</td>
</tr>
<tr>
<td>Module Objectives</td>
<td>135</td>
</tr>
<tr>
<td>Conceptual Modeling Tools</td>
<td>135</td>
</tr>
<tr>
<td>Draw on Solid</td>
<td>136</td>
</tr>
<tr>
<td>Modify Solid Entity</td>
<td>138</td>
</tr>
<tr>
<td>Delete Solid Entity</td>
<td>139</td>
</tr>
<tr>
<td>Conceptual Modeling Basics</td>
<td>139</td>
</tr>
<tr>
<td>Drawing lines on a Solid face</td>
<td>139</td>
</tr>
<tr>
<td>Projecting lines on a Solid face</td>
<td>141</td>
</tr>
<tr>
<td>Draw on Solid</td>
<td>142</td>
</tr>
<tr>
<td>Create a Conceptual Design</td>
<td>144</td>
</tr>
<tr>
<td>Module Assessment</td>
<td>150</td>
</tr>
</tbody>
</table>
Course Overview

Course Description

MicroStation V8i is used to produce 2D drawings. In addition to the comprehensive array of 2D tools, MicroStation has a wealth of 3D tools.

This course follows the transition from 2D drawing to 3D modeling using the basic tools for viewing, manipulating, and drawing and for basic Solid Modeling.

This course is recommended for the following audience(s):

• 2D Drafters or Designers
• Architects
• Engineers
• CAD Managers and Administrators

Prerequisites

• Knowledge about MicroStation 2D tools and commands
• Knowledge about MicroStation 2D view controls and AccuDraw

Course Objectives

After completing this course, you will be able to:

• Use basic 3D View Controls
• Understand Clip Volumes in 3D
• Apply AccuDraw in 3D
• Use basic solids tools
Modules Included

- Use the push-pull modeling tools
- Apply and create Display Mode Rendering

Modules Included

The following modules are included in this course:

- Transitioning to 3D
- 3D View Controls
- AccuDraw in 3D
- Basic Solids
- Conceptual Modeling
Module Overview

Construction drawings are a method of communicating 2D representations of 3D objects. Typically this 2D geometry uses orthographic projection and dashed lines to represent hidden features of the 3D object. This module provides a 2D draftsman or designer a smooth transition to 3D design.

Module Prerequisites

- Knowledge about MicroStation 2D tools and commands
- Knowledge about MicroStation 2D view controls and AccuDraw

Module Objectives

After completing this module, you will be able to:

- Understand the need for 3D modeling
- Understand MicroStation 3D space

Introductory Knowledge

Before you begin this module, let's define what you already know.
Questions

1. MicroStation can display the following number of active views.
   - 4
   - 6
   - 8
   - Any number

2. What is the name of the process for describing a three dimensional object in two dimensions?

3. The “WA” shortcut in AccuDraw allows you to:
   - Get ACS
   - Put AccuDraw on hold
   - Write to ACS
   - Quit AccuDraw

Answers

1. 8
   There are a total of 8 view windows that can be displayed at one time. A view group allows you to display any combination of these 8 views.

2. Orthographic Projection or Orthogonal Projection.
   Click here for more information

3. “WA” shortcut is used to name a new ACS and “GA” shortcut is used to retrieve an existing ACS and make it the active ACS.
2D Construction Drawings

A method of communicating a visual image to designers, technicians and engineers. In 2D drawings everyone involved in a project must be proficient in the language of 2D drafting techniques. As designs become more complex, 2D representations of the objects become increasingly more difficult.

For example, in 2D orthographic projection (top, front, and side views), there may not be sufficient information to create a mental image of an object.

With only a front view you are trying to visualize an image of the object. The front and right side views provide more information, improving the clarity of the mental image.

The top view should provide sufficient information to create a complete mental image of the object.
Some individuals have experience in viewing orthographic drawings and have no problem in creating a mental image of an object. Others may have greater difficulty, and this can produce problems in communicating essential graphical information to a design team.

Try to visualize the right side of this object.

![Top and Front views of object](image)

Select the image of the object you visualized for the top and front views above.

![From left to right A, B, C, and D](image)

The correct right side views would be both B and D.
The previous models were simple, but imagine a complex project without 3D.

2D and 3D view windows

There are eight views available in 2D and eight views in 3D. In 2D you have the X and Y coordinate system and 3D has X, Y, and Z coordinates.

In this 2D profile in a 2D view there is only geometry defined on the X and Y axes. The volume size can be modified using the Design File Settings -> Working Units category -> Advanced Settings option in the DGN File Settings dialog.
**Note:** If you attempt to change the Advanced Settings an Alert will appear suggesting you seek approval from your site administrator.

Here, the 2D profile has been extruded in the Z axis in the view. Each 3D view is a 3 dimensional cube, as shown.
3D View Controls

Module Overview

All the 2D view controls, such as Fit View, Zoom In and Out, Window Area, and Pan, can be used in 3D. As in 2D, elements to the left, right, above, or below can be excluded from a view by zooming in or windowing so that the elements are outside the view’s area.

There are also a number of 3D specific viewing tools. 3D views have depth. You can exclude the display of elements located in front of, or behind, an object by applying a Clip Volume or Clip Mask.

Hint: It is a good idea to practice using view control tools for five minutes at the start of every session, before doing any other work.

Module Prerequisites

• Knowledge about MicroStation 2D view controls

Module Objectives

After completing this module, you will be able to:

• Use 3D view control tools to navigate in 3D space
Introductory Knowledge

Before you begin this module, let's define what you should already know.

Questions

1. True or False: You can view a 3D design from any direction and even move inside it.
2. Define a MicroStation model.
3. In 2D models, you work on a design plane. What is the working area in 3D?

Answers

1. True.
2. Each model is an independent graphical space, with its own origin point, units of measurement and can be 2D or 3D.
3. In 3D models, the 2D design plane becomes a 3D cube, known as the design cube.

View Rotation

When you work in a 2D model, you can rotate the view. Visually, this is like rotating the xy-plane about a perpendicular, or z-axis. When you are working in a 3D model, you can rotate the view about any axis (the x-, y-, or z-axis). The visual effect on screen is like rotating the design cube. You can rotate any view to a standard rotation or to any arbitrary view orientation.

When you dynamically rotate a view, you can use any of the following methods.

Using the mouse

- Shift key + middle mouse button to Rotate about Center
- Pressing the left mouse button completes the rotation

Using a tool

- View Rotation tool
• Standard View Rotation

Rotate View icon and Standard View icons

These tools require a data point to start and a second data point to complete the rotation.

The Rotate View tool

Access to View Rotation is found in the view control toolbox at the top of each view window. You can also select Tools > View > View Control to open a floating toolbox.

Use view rotation to rotate a model to access a face that would otherwise be behind another. The tool settings have two options that control the method of rotation.

Cube rotation rotates the view as follows:

• In all active views moving the pointer up or down rotates the view about its x axis. Moving the pointer left or right, when Preserve World Up is:
  Enabled: Rotates the view about the model’s z-axis
View Rotation

Disabled: Rotates the view about its y-axis

Top View

Left to right, rotate about view X axis, Model Z axis and View Y axis.

Moving a view with Sphere Rotation enabled rotates the view about a center point. A dynamic sphere, and associated graphics, help you define the rotation. Slide settings let you control the size and transparency of the sphere as follows.

- Small/Large slide control: Lets you define the size of the sphere graphic in the view
- Opaque/Clear slide control: Lets you define the transparency of the sphere in the view

→ Exercise: Rotating a view using the Cube option

1. From the data set, open 3Dintro.dgn and open the 01-rotation model.
2 Select the Rotate View tool from View 1’s view control toolbox, with the following tool settings (click the Show Extended Settings arrow to view the settings for Rotation):

*Method:* Dynamic

*Cube rotation*

*Preserve World Up:* Disabled

A Cursor appears in the center of the view, denoting the center of the rotation.

3 Enter a data point on the right side of View 1.

The pointer changes shape and the Cursor becomes a small Plus Sign.

4 Move the pointer to rotate the view interactively.

Note that moving the pointer vertically rotates the view about its horizontal (x) axis. Moving horizontally rotates the view about its vertical (y) axis.

5 Reset.

This cancels the rotation and returns the view to its original orientation.

6 Select the Rotate View view control with the following tool setting:

*Preserve World Up:* Enabled

7 Enter a data point on the right side of View 1.

8 Move the pointer to rotate the view interactively.

Note that moving the pointer vertically rotates the view about its horizontal (x) axis. Moving horizontally rotates the view about the model’s (z) axis. This has the visual effect of spinning the model about its vertical (z) axis no matter what the rotation of the view.

9 Enter a data point to complete the rotation.

**Exercise: Rotating a view using the Sphere option**

1 Continuing in 01-rotation model, select Rotate View with the following tool setting:

*Sphere rotation*

Cursor appears at the center of the view and a shaded sphere surrounds them.
2 Use the Small/Large and Opaque/Clear sliders to adjust the size and transparency of the sphere as desired.

3 Following the status bar prompt, enter a data point somewhere within the region of the sphere.

   The Cursor is replaced by a small Plus Sign.

4 Move the pointer to rotate the view about the center of the sphere.

   The arrow graphic that appears on the sphere gives you a visual indication of how you are rotating the view.

5 Enter a data point to complete the rotation.

Rotating to a standard view

The standard view orientations can be selected from the Rotate View tool’s drop-down menu in each view window. You can also use keyboard mapping key-ins, or you can open the View Rotation tools as a toolbox. Remember that when you use key-ins, or use the view rotation tools from the toolbox, the tool applies to the active view.

➔ Exercise: Rotating to standard views using various view control options

1 Continuing with the 01-rotation model, open Views 2, 3 and 4 and Fit View in each.
2 Select **Window > Tile**.

3 Click the title bar of View 1 to make it the active view and in the View Rotation toolbox, select Top View.

**Note:** You can continue to enter data points in other views to change them to a standard view rotation.

4 Click **Rotate View** to open the drop-down menu and select Open as **ToolBox**.

5 Click the title bar of View 3 to make it the active view. In the View Rotation toolbox, select Front View.

6 Make View 4, the active view, and select Bottom view.

7 Make View 2, the active view, and select Right Isometric view.

---

**Rotating a view using the mouse**

The mouse wheel or button can be used for several view controls. As in 2D, you can double click the wheel to **Fit View**. Single click the wheel for a dynamic view Pan. Roll the wheel to **Zoom In** and **Out**.

You can rotate the view using the mouse and the key-in **ROTATE VIEW DRAG**.

**Exercise: Rotate view about center**

1 Continuing in 3Dintro.dgn, in the 01- Rotation model, press the **Shift** key, press the middle mouse button, and click in View 1.

2 Release the buttons and drag the mouse.
3 Enter a data point to complete rotation, or reset to return to the previous rotation.

4 Click View Previous to return to the previous rotation.

The Plus Sign is now located at the left vertical edge of the geometry.

Exercise: Rotate about any point

1 Continuing with 3Dintro.dgn, in the 01-Rotation model, press the Alt key, press the middle mouse button, and click in View 2.

As you move the pointer to rotate the view, note that rotation now is around the defined point.

2 Move the pointer over the plus sign at the center of the sphere to relocate the point about which to rotate.

3 Move the plus sign to the lower right and note that you can snap to objects.

4 Enter a data point to begin the rotation. Drag cursor to rotate.

5 Right click to end rotation.

6 Return the view to Right Isometric.

7 Fit View.
You can rotate the view using the mouse and the key-in ROTATE VIEW FROM CURSOR.

Additional 3D mouse view controls are:

- Shift key + roll is Pan with Zoom
- Ctrl key + middle button click is Rotate about point
- Ctrl key + roll is walk forward/backward
- Alt + roll is Pan left or right

Fitting 3D Views

In both 2D and 3D models, the Fit View tool lets you select whether the fit applies to elements in the Active file, References, Rasters, or All files associated with the view.

When you fit a view in 2D, the area of the view is altered to display all elements located on the levels currently turned on.

In 3D models, there are more choices relating to the clipping planes.

- All - Display all elements in the active model file and any attached references.
- Active - Display all elements in the active model file.
- Reference - Display all elements in attached references, if any.
- Raster - Display all elements in attached raster references, if any.
Clipping Planes

During a design session, you may want to work on a particular element and rotate it to view from various angles. When you do this with clipping planes set, parts may disappear or other elements may appear in the display depth.

![Clipping Planes Diagram]

Left image is a top view of location of clipping planes for the clipped image on right

Note that some of the houses in front and back are not being displayed in right image. Front and Back clipping planes can be disabled in the View Attributes dialog, or Fit View with Expand Clipping Planes enabled, will show all houses.

Clip Volumes

MicroStation’s Clip Volume tools let you select a discrete volume within the design cube for display.

![Clip Volume Tools]

**Hint:** This tool is helpful when you have elements on the same level and you do not want to see all of them.

When a clip volume is applied to a view, only elements that are located within the clip volume will display and can be snapped to in that view. Each view may have a different clip volume applied, since clip volumes are a View Attribute.

You can use 2D or 3D elements to define the volume. When you use a 2D shape, the clipping volume is created by sweeping the 2D shape through the entire
model. The sweep direction is perpendicular to the plane of the 2D element. MicroStation creates a 2D clipping shape using active attributes.

When a 3D element is used, it defines the entire clip volume.

Operations, such as view rotation, fence processing, hidden line removal, and rendering, honor the clip volumes. They ignore any elements that are not displayed within the defined volume for the view.
Clip Volumes

Closed extrusion, cylinders, or closed planar elements (shapes, circles, ellipses, complex shapes, grouped holes) can be used. If a planar element is chosen, or you use the clipping elements by points options, the clipping volume is generated by sweeping the planar element through the entire model. Planar elements may be selected in any view, because the sweep direction is orthogonal to the plane of the element. Similarly, clip elements that you define by points may be drawn in any view. AccuDraw can be used to set the correct orientation of the clip element.
The Clip Volume tool is a 3D View Control and can be found on the View Border. If you click and hold the icon you will there are other tools here:

- Clip Volume
- Show/Hide Active Clip Volume
- Delete Clip Volume

Set Clip Volume options using icons in the tool settings.

- By Element applies a clip volume from an existing element.

Section Clip Tools

- By 2 Points lets you apply a clip volume by defining a rectangular clipping element with 2 data points.
- By Polygon lets you apply a clip volume by interactively defining vertices of a polygon with data points. The polygon can be closed by entering a data point at the start point, or by clicking the Close Element button.
- Apply Fitted Clip Volume creates a clip volume that encloses all the elements in the model.

In addition, there are two check boxes:

- Display Clip Element, if on, the clip element remains displayed after creating the clip volume for the view. Display of this element can be turned on or off later, with the Show or Hide Clip Volume Element icon.
- Create Dynamic View - Allows you to create dynamic views automatically by opening the Create Dynamic View dialog.

Clip Volume Extended Options are set at the bottom of the tool settings.

- Apply Clip Volume from Named Fence creates a clip volume from the named fence, selected from the list, and applies the clip volume to the active view.
- Delete deletes the named fence selected in the named fence list.
- Save creates a named fence from the clip volume in the active view is created.
Clip Volume options

The following images were generated using a file found in the delivered Plant project.

By Element

Click here for a demonstration of Clip Volume By Element
Apply Clip By 2 Points

Apply Clip Volume By Polygon

Click here for a demonstration of Clip Volume By Polygon

Section Clip tools

There are four methods for creating a clip volume by section plane.

- Place Fitted Section (three methods). A Fitted Section is a section cut throughout the XY, YZ or XZ plane relative to the Auxiliary Coordinate System.
Clip Volumes

- Apply Clip By Section Plane located in the Create Clip Volume tool settings.

Here is the Top View and Isometric View of the train engine and tanker.

In this example, Place Fitted Section is used and an XY plane is created in the Isometric view.
The Clip Element is displayed in both views with editing handles active.

Here are the results after moving the Clip Element Handles in the XY direction.

The Top view shows the Clip Element but the Clip Volume is displayed in the view selected when creating the Clip Volume, which was the Isometric view. Here is the Clip Volume after Selecting the Show or Hide Clip Element tool.

Clip Volumes and View Attributes

The View Attributes dialog includes Clip Volume Settings. When a view contains a Clip Volume, the View Attributes dialog will display a Clip Volume collapsible.
Clip Volumes

section. The settings on this section provide various ways to display the Clip Volumes.

In this view, the Clip Volume Settings of the View Attributes Settings are set to display the Forward volume of the Clip Element with the From View option enabled. The Back, Cut and Outside options are disabled.

Here is the same view with different options selected from the Clip Volume Settings.
Clip Volume settings and Display Style

When a Display Style is created or an existing style is modified, enabling the Clip Volume box in the Display Style window will place the style as an additional option in the Clip Volume Settings. Clicking on the magnifying glass will open the Display Styles dialog.

Applying a clip volume

You can use a clip volume to isolate a part of the model so that you can work on it without the confusion from the display of other parts of the model.

Exercise: Applying a clip volume by 2 points.

1. Close the file you are in and set the following in the File Open dialog:
Clip Volumes

User: Examples

Project: Plant

2  Open BSI700-A0101-PumpHouse.dgn.

3  From the View Control or the Clip Volume toolbox, select Clip Volume with the following tool settings:

   Apply Clip Volume By 2 Points

   Display Clip Element: Enabled

Create Dynamic View: Disabled

4  In the View Rotation toolbox, select Top View.

   This View Rotation was transparent (you stay in the Clip Volume command) as it knew which view to apply the command to.

5  Enter data points to create a clip element.
6. Enter a data point in the view to accept the clip volume.

![Clip Volume]

7. From the View Control or the Clip Volume toolbox, select Clip Volume and Show or Hide Active Clip Element, then select view.

   The clip element will disappear.

8. Use Shift + middle mouse button (press in), or select Rotate View to rotate the View.

   Note that only the elements in the clip volume are visible during the rotation.

9. In the View Rotation toolbox, select Isometric View.

10. Fit View.

    No other elements appear in the view.

11. To remove the Clip Volume select the Clear Clip Volume tool and enter a data point in the view.

    ![Clip Volume cleared]
Exercise: Applying a clip volume by section clip tools

1. Continuing in BSI700-A0101-PumpHouse.dgn, from the View Controls or the Clip Volume toolbox, select Clip Volume with the following tool settings:

   **Section Clip Tools**

   *Apply Fitted Section XY-plane*

   **Display Clip Element:** Enabled

   **Create Dynamic Views:** Disabled

2. In the View Rotation toolbox, select Top View.

3. Enter 2 data points from top to bottom, to create a section through the Pump House.

4. In the View Rotation toolbox, select Isometric View.
5 Open the View Attributes dialog using the View Control tool or by pressing Ctrl+B.

Note: Since a clip volume exists in View 2, there is a Clip Volume Settings tab.

The forward and back view style of the section plane are displayed on the Clip Volume Settings tab, and are set to “From View”.

6 Select the “Outside” option for the Back area of the section plane and the view displays dashed lines to indicate the Back of the section plane is now hidden.

7 Enable the display of the Cut area. The “From View” will display by default.
8 Change the display option of the Forward area of section plane to Outside. The new display of the clip volume section should look like the following view.

9 Use the Element Selection tool and select the section clip element. The boundaries of the interactive clip element display.

10 Move the green handle to re-position the section plane and move the blue handle to modify the size of the Forward area of the section plane.
11 Clear the clip element selection by a data point in the view.

You can right-click on the green arrow and Flip Direction, Clip All Sides or Un-clip All Sides or right-click on a blue arrow and can Toggle Clipping, Clip All Sides or Un-clip All Sides. Toggle Clipping will change the blue arrow to a blue bolt.

12 Modify the Clip Volume Settings:

13 To remove the Clip Volume select the Clear Clip Volume tool and enter a data point in the view.
Manipulating a clip volume from a second view

With a clip volume active, you can restrict the display of elements to just those that you want to see. Once a clip element has been created, you can manipulate it to change the clip volume and the information being displayed. If you later move, or modify a clipping element, the clip volume is also moved or modified. If you delete a clipping element, the view clipping is removed. Clipping elements can be manipulated or modified with the standard MicroStation tools.

Once a clip volume has been applied to a view, you can switch the clipping on and off in the View Attributes dialog using the Clip Volume check box. You can toggle display of the clip element using the Show or Hide Clip Volume Element icon in the tool settings.

Exercise: Manipulating a clip volume

2. Open Views 1 and 2 and Tile them.
3. Set View 1 to Front and set View 2 to Isometric, and then Fit View in each.
4. In the Clip Volume tool settings, set the following:
   Section Clip Tools
   Apply Fitted Section XY-Plane

5. Enter a data point in View 2.
7 In View 1, snap to the clip element and move it in the - (negative) Z direction.

View 2 displays the new Clip Volume. Experiment with the blue handles to make more changes to the Clip Volume. Here is an example.

8 To remove the Clip Volume select the Clear Clip Volume tool and enter a data point in the view.

**Saving clip volumes**

You can save clip volumes as named fences in the current file, for later use. You then can apply them to any view. You can also create a Dynamic View, which will be covered later.

**Working with multiple clip volumes**

Each view in a model can have a clip volume assigned to it. These can be identical, or they can be different. Saving clip volumes lets you quickly set up views to work on specific parts of a design. Once a clip volume is defined for a view, it remains with that view until you clear it. Tools such as the Fit View tool will not change the extents of a clip volume.
Using a clip mask

A clip mask has the opposite effect to that of the clip volume. A clip volume defines what to display, but a clip mask defines what not to display. Procedures for creating and using clip masks are identical to those for clip volumes. You can apply clip masks to views that have had a clip volume applied.

Similarly, you may want to work on part of a model, while hiding another part of it. If the elements all are on the same level, you can use the Clip Mask tool to mask the elements that are not required.

Using 3D Clip Masks you can easily create cut-away drawings.

Exercise: Apply and clear a clip mask

1. Continuing in BSI700-A0101-PumpHouse.dgn, make View 2 the active view.
2. Select Clip Mask from the view control toolbox.
The tool settings are similar to the Clip Volume tool. The named fences you created previously can be used with clip masks too.

3. Select the named fence Back Wall in the tool settings.

4. Click Apply Clip Mask By Named Fence.

The view updates and the back of the pump house is masked from the view. Fitting and rotating the view will not cause it to reappear. Though you can Fit and Rotate the clip masked view.

Clearing a clip mask is the same as a clip volume.

5. Click Clear Clip Mask in the tool settings.

6. Enter a data point in View 2.

7. Select File > Close.
Display Styles Dialog

The Display Styles Dialog is for modifying and creating custom display styles or render modes. Display Styles can come from a DGNLIB or can be stored in the active DGN. Like similar Styles dialogs (Text, Dimensions, etc.) you can Update from Library to make sure you are using the latest styles.

You can access the Display Styles Dialog from the following locations:

- Settings > Display Styles... or Tools > View > View Control... or View Attributes Ctrl+B
- In the View Toolbox click the Open Display Style Dialog icon.

Standard display styles are provided.
Modifying Display Styles

This is an example of the default Display Style called Illustration.

Create a new display style by selecting Copy in the Display Style dialog and changing name to something descriptive, such as Illustration with blue lines. Go to the Edge Settings category in the dialog and modify color of Visible Edges.
Experiment with these settings. It is now possible to set the background Environment for the display. Environments is a topic that is explained in the Luxology Visualization course.

Review effects of the Display Style dialog tools

1. Wireframe - Tool settings:
No settings

2. Hidden Line - Tool settings:
   Display: Hidden Line

3. Filled Hidden Line - Tool settings:
   Display: Filled Hidden Line

4. Smooth - Tool settings:
   Display: Shaded
5 Illustration - Tool settings:

Display: Shaded
Display Visible Edges: Enabled (Black)
Background Color: Enabled (White)

The Display Styles Dialog setting Usages when enabled, determines if the display mode is created in view window or Clip Volume or both.

Exercise: Create a custom display style

1. Open BSI700-S0501-UnloadingPlatform.dgn, make View 2 the active view.
2. Select Settings > Display Styles.
3. Select New and type over Untitled with the name Custom Display.
4. Set the Display Styles settings as follows:
   Display: Shaded
   Display Shadows: Enabled
   Enable No Material: Select the Material option
   Select magnifying glass: Select Platform Frame material
   Enable Background color: Select Color 48
   Enable Usages: View
5 In View 2, select the View Display Mode tool drop down arrow and select Custom Display.

Perspective

Every time you turn on perspective in a view, you turn on the Camera (View Attributes > Camera). You can turn perspective on specifically using the View Perspective tool.

A single data point in the view center starts the 3 point perspective, and movement away from the center changes the amount of perspective. Selecting the View Perspective tool and double clicking in the center of the view sets the view to parallel projection, or turn off the Camera in View Attributes.

Additional options are available if you click and hold the View Perspective tool or open it as a toolbox. Right-click on any tool to Show All tools.

- View Perspective interactively set perspective in a view
- Wide Angle sets perspective in a view to match an extra wide angle camera lens
- Normal sets perspective in a view to match a normal camera lens
- Telephoto sets perspective in a view to match a telephoto camera lens
- Two Point Projection sets perspective in a view to 2 point projection. Hidden by default
- Camera Off turns off a view camera and return to parallel projection
Saved Views

Used to name, save, delete, import, apply and recall saved views. Saving a 3D view allows you to quickly recall a view with specific attributes. It is important to create and use Saved Views in 3D, since you will want to return to a known position many times. They are helpful for design, navigation, rendering and animation. Camera and Clip Volume settings are available for saving or recall.

Open the dialog by selecting Utilities > Saved Views, selecting View Save/Recall from a view window control menu, or pressing F6.

The Saved Views dialog

The Saved Views dialog contains controls that are used to apply a saved view to a view in the design file. The list box shows the name, description and model of each view saved. To apply a saved view, use the following options:

Apply to Selected Views. Select this tool and click in a selected view window.

Apply to open views. All opened views will display the Saved View.
Double click the entry in the Saved View dialog list will display the Saved View in the Active View.

**Active File**

This icon displays optional settings by clicking on the drop-down list box.

![Active File Icon](image)

A link is a pointer to project data and a link set is created when you use Project Explorer (*File > Project Explorer*).

**Create Saved View**

Opens the Create Saved View dialog where you name and describe the view you are saving. The view can be a saved, section, elevation, detail or plan view. A Clip Volume can also be added to a Saved View Option or a Dynamic View can be created.

![Create Saved View](image)

> **Exercise: Create a Saved View**

1. Continuing in BSI700-S0501-UnloadingPlatform.dgn, open Views 1 through 4, select to Window > Tile, and then Fit each view.
2. Set Display Mode to Wireframe for each view.
3. Window in on the top of the Unloading Platform in View 4 (Right View).
4 Set Display Mode to Smooth with Shadows and apply the View Perspective Extra Wide Angle. Pan and Rotate to adjust if needed.

5 Press F6 to open the Saved View dialog, click Create Saved View, and save the new view in View 4:

   **Name:** Top Platform

   **Description:** Top platform with wide angle view

6 Click in View 4 to select the source view.

7 In the Saved Views dialog, set the View number to View 3 and double click the Top Platform saved view in the saved view list box.
In the Saved View dialog list box, click on the area below the header “Clip Volume” to select an existing clip volume.

**Module Assessment**

Assessment is often equated with evaluation, but the two concepts are different. Assessment is used to determine what an individual knows or can do. Complete the assessment to see what you have gained from reviewing this module.

View Controls Assessment
AccuDraw in 3D

Module Overview

AccuDraw is an intelligent drawing aid that interprets the position of the pointer relative to previous data points, view orientation, and coordinate system. Using AccuDraw, you can quickly enter additional data points that build on those entered previously.

Module Prerequisites

- Knowledge about AccuDraw in 2D
- Knowledge about basic 3D view controls and 3D planes

Module Objectives

After completing this module, you will be able to:

- Design with AccuDraw in a 3D environment
- Use Auxiliary Coordinate Systems to control drafting planes
- Use AccuDraw 3D shortcuts
The AccuDraw Drawing Plane

AccuDraw was designed to work with the 3D drawing environment. You can work in a view other than one of the orthogonal views (Top, Front, and Right), but still draw on the orthogonal planes. When you click in the top view and have selected a tool that can utilize AccuDraw, the AccuDraw Compass or Drawing Plane displays. The red indicator is the X axis and the green the Y axis. The top view permits you to draw in the 2D X and Y plane.

How to create a 3D model created from 2D rectangles

In this example, the objective is to create a 3D model created from 2D rectangles oriented in 3D space so that the model looks like the following image.

A rectangle is drawn in the top view.

1. Select the Place Block tool with the following tool setting:

   Method: Rotated

   The top, front, right, and right Isometric views will display the rectangle as viewed in each orthogonal view.
2. The next step is to draw a rectangle in the front view.

The front view is the XZ view and the AccuDraw plane must be oriented to the front plane. This is accomplished by using an AccuDraw shortcut. When focus is on AccuDraw and the AccuDraw symbol is displayed in the lower right corner of the MicroStation application window (F11), then type the letter “F”, and AccuDraw will orient itself to the front drawing plane.
Note: In this example the default depth of the view is set to the Independent Auxiliary Coordinate System for this model. Auxiliary Coordinate Systems will be covered later in the course.

The next 2D rectangle must be drawn in the right view or the YZ plane and the AccuDraw plane must be oriented to this view.

3 Type “S” to orient to the side drawing plane. Draw a rectangle as in the previous step.

The Right Isometric view (View 2) shows the three 2D planes oriented in 3D space.
Let’s take a look at an image that gives you a visual cue for remembering the orientation of AccuDraw drawing planes.

AccuDraw shortcut. You do this by rotating AccuDraw’s compass to an orthogonal plane with one of the shortcuts V (view), T (top), F (front), S (side) and V for alignment with view.

Note: Remember that the focus must be in the AccuDraw window for its shortcuts to work. Press F11, or press Esc and then the space bar to move focus to it.
Here is a real world object displayed in all four standard orthographic views (Top, Front, Right Side and Right Isometric views).

There are two typical view layouts for working on 3D designs. Of course, these view layouts can be changed to any layout where necessary. The first is the layout of standard orthographic views above. It is recommended that you work in the Right Isometric view with the Top, Front, and Right views open.

Another method is to work totally in the Right Isometric view and display the other views when needed. This later method is what will be demonstrated in this course and an added benefit, is a larger image to view on the monitor. This method keeps you focused on 3D space and speeds up the learning process of working in 3D space.

**Drawing in 3D**

Why would you draw lines in 3D? Not all 3D shapes are orthogonal, so lines and curves are used to create paths and edges that are used in 3D modeling techniques. Before you learn these techniques, you need to learn some new AccuDraw shortcuts and use the AccuDraw planes previously covered.

The following are images of the next exercise, Drawing in 3D Space.
Exercise: Drawing in 3D Space.

1. Open the 02-AccuDraw model in the data set's 3Dintro.dgn file. View 2 should be the only view opened for this model.

2. Select the SmartLine tool and verify AccuDraw has focus in lower right corner of MicroStation application window. If not then type <F11>.

Use the following sketch as a guide to place points in 3D space.

3. Enter a data point on point 2 then type <T> for Top orientation of the AccuDraw drawing plane.
4 Move the cursor 1 unit in the +Y direction of the AccuDraw compass and then press the letter <o>.

5 Move your cursor 1 unit in the +X direction and press the letter <o>.

6 Type <S> for Side orientation of the AccuDraw plane and move cursor 1.5 units in the +Y direction and place a data point.

7 Move cursor 1.5 units in +X direction and type the letter <o>.

8 Change the AccuDraw plane to the front orientation by typing <F>.

9 Move the cursor 1 unit in the +X direction and type the letter <o>

10 Move the cursor.5 units in +Y direction and place a final data point.

11 Select the B-spline curve tool with the following settings:

   Method: Through Points
   Input By: Picking Linestring
   Closure: Open
   Tangents: Start

   Click on the linestring you just created,

12 Select the create Complex Chain tool with:

   Method: Manual

   Select line from point 1 to point 2 and new B-spline curve to create a single linestring.

13 We need to mirror this curve about a line. Select the Mirror tool with:

   Mirror About: Line
   Make Copy: Enabled

Click here to see a video of this exercise
14 Select the curve with the AccuDraw plane set to Side orientation and then select top of green line and then bottom.

15 Using the Create Complex Chain tool unite these two curves into a single open linestring.

Open linestrings such as the one you created are typically used as drive curves for Surface and or Solid modeling techniques. In this image a 2D shape was swept along the previously created 3D curves.

3D Element Placement

Placing elements in a 2D file is like drawing on a sheet of paper. All elements are on one plane, the $x,y$ plane. When you place the same elements in a 3D file, by default they are placed in the AccuDraw drawing plane. The AccuDraw drawing
plane can be rotated to match the view being used, or defined to be a particular rotation.

In the following exercises, you will draw an open rectangular box using 2D blocks.

→ **Exercise: Open the model and draw the base surface**

1. **Open the 03-AccuDraw-3DDraw model in 3Dintro.dgn.**
   
   This model displays the ACS triad, which indicates the directions of the 3 axes, in each view. You can toggle the display of the ACS triad in the View Attributes dialog.

2. **In the Task dialog, click on the Solids Modeling task.**

3. **Select the Place Block tool.**

4. **Make sure focus is in the AccuDraw dialog window by clicking in AccuDraw dialog or typing F11.**

5. **Enter a data point anywhere in the view and type T for Top Rotation of AccuDraw Compass.**
6 Move the pointer along the Red axis or AccuDraw’s x-axis, type 1.5. Do NOT press left mouse button and move pointer along the Green Y axis for a distance of 1.251.25.

7 Enter a data point to complete the block.

8 Fit view.

Exercise: Use AccuDraw Shortcuts to draw corresponding faces for the box

1 Continuing in the 03-AccuDraw_3DDraw model, select the Place Block tool.
2 Snap to the left end of the existing block and accept with a data point.
3 With focus on AccuDraw, press <S> for the Sides rotation.
4 Move the pointer to the right, AccuSnap will place an X on the end point, press <X> to lock the x axis. Move the pointer in the Y direction for a distance of 0.5 and enter a data point.
5  Enter a data point to complete the Block.

6  Fit View.
    For the right face, you can snap to existing elements to place the points.

7  Select Place Block.

8  Press <F> for Front rotation.

Note: Press F11 to put focus in the AccuDraw window.

9  Snap to the bottom left end of the base and accept with a data point.

10 Continuing in the Isometric view, snap to the top of the front surface and accept with a data point.
11 Fit View.

To complete the box, you can use the Copy tool to copy the existing faces creating the opposite sides. When you copy an element in 3D, it retains its current orientation. That means that a vertical face remains vertical, a horizontal face remains horizontal, and so on.

⇒ Exercise: Copy the existing faces to complete the box

1 Continuing in 03-AccuDraw_3DDraw model, select Copy Element, with the following tool setting:

Copies: 1

2 In the Isometric view, identify the block representing the back face at its lower right vertex.

The face is attached to the pointer. As you move the pointer in the other views, the front face element retains its current orientation.
3 Snap to the front right vertex of the base block.

4 Enter a data point to complete the copy and reset.

5 Identify the block representing the Front face at its lower right vertex.
6 Snap to the back right vertex of the base block and accept to complete the copy.

7 Reset.

8 Click the View Display Mode view control and change the Isometric view’s display to Illustration Default.

9 Use the Rotate View tool to rotate the view and verify that you have correctly drawn all the surfaces for the open top box.

As you can see, placing elements in 3D is no more difficult than in 2D. This entire exercise was accomplished in a Right Isometric view. Working in Isometric views
3D Element Placement

reduces the ambiguity created by orthographic views, like Top, Front and Right Side views. A simple rotation of view will show all sides.

Click here to see a video of the Draw the Base and Copy Faces exercises

Using AccuDraw’s rotated drawing plane

You can place elements in the Top, Front and Side alignments using AccuDraw’s <T>, <F> and <S> shortcuts.

AccuDraw’s drawing plane lets you work in any view, while still maintaining the correct plane for the elements being drawn. You can still snap to elements that are not on the current drawing plane and AccuDraw responds accordingly.

As you draw in 3D, you may observe the drawing plane axes change as you enter data points. The alignment of the drawing plane depends on the tool being used and the location of the previous data points. For 3D models, the 3 previous data points are considered, as this is the minimum requirement to describe a planar surface. Where less than 3 data points have been entered, the view orientation is also considered.

Additional shortcuts

• <B> Base Rotation: Rotates the drawing plane to align with the active ACS or the rotation of the view.
• <E> Cycle Rotation: Rotates between 3 main planes; top, front, and side. Pressing E rotates the drawing plane first 90° about its x-axis, then 90° about its y-axis, and then back to its original rotation.

In the following exercises, you will work in the Isometric view and let AccuDraw correctly align the elements. As you work through the exercise, use the other open views to check the orientation of the element being drawn, by maximizing and shrinking the Isometric view.

➔ **Exercise: Automatic drawing plane rotation in AccuDraw**

1. Continuing in 03-AccuDraw_3DDraw model, Pan to an open area of the model.
2. Change view to Isometric.
3. Select Place Block.
4. Place 2 orthogonal blocks as shown.
5 Continuing with Place Block, snap to the vertical face upper right corner.

6 Press <T> to rotate AccuDraw’s drawing plane to Top.

7 Snap to the lower right vertex of the base.

AccuDraw uses the 2 data points plus the view to set the drawing plane orientation. This results in a drawing plane that is not always in alignment with any of the standard Top, Front or Side drawing planes.
8 Snap to the lower left edge of the base and accept with a data point.

AccuDraw’s drawing plane now aligns itself with the plane of the 2 non-planar data points.

9 Reset to complete.

Non-orthogonal rotation

Quite often, you will need to rotate the AccuDraw compass to a non-orthogonal plane; one that is not the Top, Front or Side. Besides the standard non-planar data points and view rotation, or non-planar snapping, several other methods are available. The most common is to use an AccuDraw shortcut.

- RQ - Rotate Quick provides quick, non-persistent rotation
- RA - Rotate ACS allows you to persistently rotate x and y plane about an origin point. You can clear it by using a standard rotation like T,F, S, V
- WA - Save an ACS rotation
- GA - Recall an ACS rotation
- E - Cycle Rotation
  Important when using another ACS since T, F or S will break you out of existing ACS
- RX - Rotate about x-axis
- RY - Rotate about y-axis
- RZ - Rotate about z-axis
- RE - Rotate AccuDraw compass to match orientation of an element
3D Element Placement

- RV - Rotate Active View to orientation of AccuDraw compass

**Exercise: AccuDraw and Quick Rotation**

1. Continuing in the 03-AccuDraw_3DDraw model, select *Edit > Undo* to undo the placement of the last inclined plane.
2. Select Place Block.
3. Press F11 and then press *<T>* for top rotation.
4. Following the status bar prompt, snap to the upper left vertex of the vertical face and accept with a data point.
5. Press *<RQ>* and, following the status bar prompt, snap to the lower left vertex of the base, then accept the new rotation with a data point.
6 Snap to the right lower vertex of the base and accept the new block with a data point.

An alternate method is to use Place Block with the Method set to Rotated.

To keep a persistent rotation, you can use the AccuDraw shortcut <RA>.

**Exercise: Using RA to keep a rotation**

1 Continuing in the 03-AccuDraw_3DDraw model, select Place Circle with the following tool setting:

   *Method*: Center

2 Snap to the upper left vertex of the vertical face, press F11, and then press <O> to set the AccuDraw origin, but do not enter a data point.

3 Press <RA>, keeping the snap point the same, and enter a data point to accept the origin.
3D Element Placement

4  Snap to, and accept, the upper right vertex of the vertical face to show the x-axis direction.

5  Snap to, and accept, the lower left of the base to set the y-axis direction.
6 Press the space bar to change to the rectangular coordinate system.

7 Snap to, but do not accept, the left midpoint of the inclined plane and lock the y-axis by pressing <Y>.

8 Press <K> to open Keypoint Divisor dialog and set the divisor to 3.
3D Element Placement

9 Snap to left third of the long edge of the base to set the x-axis distance, and enter a data point to accept the center point of the circle.

10 Type a distance of 0.2 for the radius and accept with a data point.

Save the rotated ACS with AccuDraw shortcut <WA> and save as angled plane. The named ACS will appear in the Auxiliary Coordinate dialog.
A quick rotation method is to rotate to an element's plane.

⇒ Exercise: Quick Rotation to an element

1. Continuing in 03-AccuDraw_3DDraw.dgn, with focus on AccuDraw, press <T> to set Top rotation.

2. Select Place Circle, with the following tool settings:
   - Method: Center

3. Press F11 to put focus in the AccuDraw window.

4. Snap to, but do not accept, the midpoint of right edge of the inclined plane and press <O> to set the AccuDraw origin at the midpoint.

5. Press <RE> to Rotate to Element.
6 Align the compass to the right inclined edge.

7 Enter a data point to accept the rotation.

8 Index to the left and press Enter.

9 Snap to a point one-third of the way along the bottom edge and enter a data point to place the center of circle.
10 Index to any axis and type a radius of 0.2.

Other tools that rely on the plane orientation also can be used with AccuDraw. For example, the Mirror, Rotate Element, and Array tools all use the plane orientation to define the direction of the mirror, or the axis of rotation.

**Locating elements relative to others**

There will be occasions when you will locate elements relative to others already present in the model. In the following exercise, you will place a SmartLine to represent the center lines for the 2 pipes.
Exercise: Draw the center line through pipes AB and CD

Tools to use in this exercise:

- Enter key for Smartlock
- AccuSnap Center point
- Press <O> for origin
- SmartLine with Vertex Type set to Rounded (.5 radius)

1. Continuing in 3Dintro.dgn, open the 04-AccuDraw Exercise model.
2. Use the tools listed to make your model appear as follows.

Hint: The Display Style used is Display, which is Hidden Line with hidden lines dashed

Optional Exercise: Routing a line through center lines of holes

2. Using Place SmartLine, draw a continuous line through the center of all holes cut through the solid slab. Start where indicated.
Using Auxiliary Coordinate Tools

You can define new x- and y- axes in your design plane and save them as an auxiliary coordinate system (ACS). You can define several auxiliary coordinate systems and quickly choose any of them to use. At any time, you can make one ACS active per view.

<table>
<thead>
<tr>
<th>Name</th>
<th>Scale</th>
<th>Origin X</th>
<th>Origin Y</th>
<th>Origin Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>View 1: Unnamed</td>
<td>Full Size 1=1</td>
<td>2.5000</td>
<td>2.5000</td>
<td>3.7500</td>
</tr>
<tr>
<td>absolute ACS</td>
<td>Full Size 1=1</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>Angled Plane</td>
<td>Full Size 1=1</td>
<td>2.5000</td>
<td>2.5000</td>
<td>3.7500</td>
</tr>
</tbody>
</table>
Using Auxiliary Coordinate Tools

Same ACS active in each view
Using Auxiliary Coordinate Tools

Auxiliary coordinate systems can be particularly helpful in 3D design, where they facilitate placing elements on planes at different depths and orientations. By using an ACS that corresponds to the location and orientation of a particular element, you can enter data points relative to that element rather than the global origin.

Once an ACS is active you can use it with AccuDraw and with precision input key-ins (such as AX= and AD=) to perform precision input with respect to the auxiliary coordinate systems.

**Hint:** The active ACS in each view is shown in color.
You can also use AccuDraw shortcut key-ins to define and activate auxiliary coordinate systems.

MicroStation provides specific tools for creating, modifying, importing and selecting Auxiliary Coordinate Systems. You can find the tools by selecting Utilities > Auxiliary Coordinates or right click and turn on the tool in the Primary Tools toolbox.

An auxiliary coordinate system (ACS) is a coordinate system with an orientation, and/or an new origin, different from those of the DGN file coordinates (the Global Origin). Although not exclusively a 3D concept, an ACS is most useful in 3D modeling as a drawing aid.

Tools from left to right are:
- Create a new ACS
- Copy ACS
- Delete ACS
- Import ACS
- Define ACS (By Face)
- Define ACS (By Points)
- Define ACS (Aligned with View)
- Define ACS (Aligned with Reference)
- Rotate ACS
- Move ACS
- Apply ACS to Selected View
- Select ACS

Active Depth is no longer used, because the location of unsnapped points is controlled by the ACS for a view. Instead of Depth Lock, you now can enable ACS Plane Snap to force unsnapped points to fall on the plane of the ACS.

For example, in this top and side view of the Angled Plane ACS, the ACS Plane Snap lock is enabled.

Therefore, when you draw in the top view, the lines will snap to the Angled Plane.
Auxiliary Coordinates dialog tool features

- A new ACS can be created using the Create a new ACS tool in the dialog.
- You do NOT need to create an ACS before you define it. Using a Define ACS tool will create an ACS for you.
- A list box now displays the active ACS on the top line and all ACS’s in the active model.
- All ACS tools are available within the dialog.
- Ability to create, copy, delete or import an ACS.
- Make an ACS active by double clicking on ACS name in list or right-click on ACS name and select Set Active from options list.
- Other options include ability to match the coordinate system of selected ACS to the active ACS or global coordinates for the model, and deleting or renaming an ACS.
• Left click on the Type and change it to None, Rectangular, Spherical, or Cylindrical.

**Important notes on the ACS system**

The active ACS for a view is NEVER a named ACS, it is a copy. You can set it from a named ACS and, as long as it still matches the named ACS, it will display the name that show where it originated.

For example, set a named ACS for a view, then change it by using the AccuDraw shortcuts RA, E, Define ACS by Points tool, etc. Only the active ACS for the view is changed and the connection with the named ACS is broken (the view becomes unnamed). Otherwise, you would have to be very careful not to inadvertently re-define your carefully setup named ACS.

**Note:** Notice in right image above the ACS changed when the <S> shortcut was selected. Check Auxiliary Coordinates dialog below image, Angled Plane is no longer active.

The reverse is also true. Set a named ACS on the view, then modify the named ACS directly (for example, enter new origin values for a named ACS using the ACS dialog). The active ACS values are un-affected and just the connection with the
named ACS is broken. In both cases you will see that the active ACS loses its name immediately in the ACS dialog.

The View Independent toggle (right click on a named ACS in the ACS dialog to select command) is a little different. It is currently only a property of the active ACS, not a named ACS. As long as the other settings are the same you can toggle it on/off without breaking the connection to the named ACS, but if it is left view independent MicroStation will stop showing the name when you re-open the file because the active ACS would have been saved without a fixed rotation. With a view independent ACS the xy-plane is always aligned parallel to the view at the defined depth or the equivalent to active depth in V8i.

So the main thing to understand is that a view’s ACS is completely independent of any named ACS, the name is just a helpful hint as to how it was setup that is only valid as long as nothing is changed.

ACS and the depth Lock

MicroStation V8i no longer has a Depth Lock. It is replaced by the ACS Plane Lock. The ACS always defines your working plane now, it is not going to be some static thing that you just leave at 0,0,0 with an identity rotation and never use.

To mimic depth lock you can setup a view independent ACS, which is the default for files that did not have ACS Plane Lock enabled and what the set active depth
tool now does. Then turn on ACS Plane Snap from Settings > Locks > ACS Plane and ACS Plane Snap or use AccuDraw shortcuts LP, LA and/or LS.
Using Auxiliary Coordinate Tools

Working in Top view simply make ACS-2 active and draw then make ACS-3 active and draw. When completed all geometry will appear on each active ACS.

ACS and depth lock questions and answers

1. Do I need to set up view oriented ACS for each rotated view?
   You certainly can. You could have an ACS for your elevation view that is always front and your plan view that is always top, etc. However, if you typically work with a single view and frequently switch between standard rotations to draw on different planes aligned to the view, changing the ACS would get tedious. A view’s ACS can now specify that it is view independent, in other words, defines a point that a plane aligned with the view passes through, effectively the active depth concept but without having to worry about viewing operations inadvertently changing it out from under you. If you have display of the ACS enabled for a view, a view independent ACS displays the triad arrows with a dotted style instead of solid.

2. How does this affect the coordinate readout in the status bar?
   First, use Running Coordinates (right click on the Status Bar and select). Then by left clicking on the Running Coordinates box in the Status Bar you
can choose to display: Position, Delta, View Delta, Distance, ACS Position, or ACS Delta.

3 I heavily rely on view active depth for rotating views. I would have thought that when no ACS is enabled, then the active depth and depth lock should work as before.

The ACS is effectively always enabled. ACS Plane Lock now just controls whether viewing operations and AccuDraw shortcuts for T, F, S are relative to the design coordinates or the ACS. It also controls whether the ACS scale will be used (in the case where you have explicitly set a scale other than 1.0 for your ACS).

4 We use SET TPMODE LOCATE. How does this affect us?

It should not affect you. To always report coordinates relative to the global origin, use tpmode locate. If you do not want the snap point projected to the active ACS Plane (i.e. active depth) turn off ACS Plane Snap just as you would have had to turn off Depth Lock in previous versions. Use TPMODE ACSLOCATE only if you set a specific ACS for your view, and the expectation here is that these users will use the ACS tools and ACS dialog and not use the old active depth tools. You can also change your mode with Running Coordinates.

5 Do I always need to use ACS Plane Lock and ACS Plane Snap Lock in my workflow now?

The ACS locks is for someone who has setup an explicit ACS to a meaningful location/orientation. ACS Plane Lock is not needed to control whether un-snapped points are projected to the ACS Plane, that always happens now.

6 How do I save my ACS’s?

ACS’s are saved when you use the Save Settings command.

Set Active Depth tool

The Set Active Depth tool was left in the interface because it is a familiar and easy to use tool for people that were not accustomed to using an ACS. The implementation of the tool has changed to define a view independent ACS at the point you select. Turn the View Attribute for ACS on so you can see what it is doing.
AccuDraw shortcuts for ACS

Although using ACS’s may seem complicated, AccuDraw uses them as a basic part of its 3D functionality, permanently storing arbitrary rotations. It is not necessary to learn much about ACS’s to use them effectively with AccuDraw.

AccuDraw drawing plane shortcuts for Top, Front and Side are relative to the active ACS rather than the Default coordinate system.

- **LP** - Lock ACS Grid Plane - Toggles ACS Grid Plane lock, which toggles the ACS Plane and ACS Plane Snap locks, and the Grid view attribute for all views. Very helpful shortcut. The F8 key is mapped to the same command.

- **LA** - Toggles ACS Plane lock.
- **LS** - Toggles ACS Plane Snap lock.
- **LZ** - Toggles Sticky Z Lock, which can be used in conjunction with ACS Plane Snap Lock to force a series of snap points to lie on the active ACS’ XY plane (Z=0).

One possible AccuDraw and ACS workflow

1. Draw/Reference an element for the rotation you need.
2. Use AccuDraw shortcut <RE> for Rotate [compass to] Element, and AccuDraw will rotate to the orientation of this element.
3. Use AccuDraw shortcut <WA> for Write ACS, and a new ACS will be created with the name you choose.
4. Use AccuDraw shortcut <GA> for Get ACS, this gives you a menu to select your ACS’s.

When opening the ACS dialog, you will see your ACS Systems, right click on the title-list of this menu, and you can turn on and view the rotation of your ACS.
Exercise: Creating and drawing on a new ACS.

1. Continuing in 3Dintro.dgn, open the model 05_ACS_by_points.

2. Select the ACS By Points tool from the Auxiliary Coordinates dialog with the following tool settings:
   
   **Type:** Rectangular

3. Enter the new ACS origin at point 1.

4. Define the x-axis by placing a data point on point 2.

5. Enter a data point on point 3 to identify the y-axis direction, and the new ACS will display.

6. To create a new ACS, click the Create a new ACS tool in the dialog and type a name for the new ACS.

7. Double click the new named ACS.
   
   It will become the Active ACS and will display on the first line or Active ACS line of the dialog.

8. Select Place Block with the following settings:
   
   **Method:** Rotated
   
   **Area:** Solid
Fill Type: None

Note: When drawing on a rotated ACS use the AccuDraw shortcut <LA> to lock the ACS Plane.

9 Enter the base point of the block at the midpoint of the edge between points 1 and 3.

10 Enter the second base point of the block at the midpoint of the edge between points 1 and 2.

AccuDraw will automatically rotate orthogonal to ACS2.

11 Move the pointer along the green y-axis for a distance of 1.

12 Render using the Smooth or Hidden Line View Display Mode.

Define an ACS aligned with a reference file

The following image shows a simple reference attached to the model.
To set the ACS so that it is aligned with the ACS of the Reference, use the Define ACS (Aligned with Reference) tool. Select the Reference and the Reference ACS becomes the active ACS.

ACS interaction with AccuDraw

Use the AccuDraw shortcut <LA> to lock the active ACS plane. This will let you use the <T>, <F> and <S> shortcuts relative to the active ACS.

Use the AccuDraw shortcut <LP> or default function key <F8> to turn on the ACS Plane, ACS Plane Snap and grid for all views. The following image shows the results of using the <LP> or <F8> shortcut.

Separate ACS per View

A new tool in the ACS toolbox lets you assign Auxiliary Coordinate Systems to each view. You can create an ACS for a view with the Define ACS by View tool. You can make the ACS view-independent by turning on a check box. When a view-independent ACS is active, and the ACS triad setting is enabled for the view, the X,
Y arrows are displayed as dashed in the view. To retain the per-view ACS setting for the next session, you must select *File > Save Settings.*

When a model created in an earlier version is opened and the ACS Plane lock is not enabled, a view-independent ACS with an origin of the view center at active depth is created. This lets you start working with the geometry created in the same place as it would have been in the earlier version (at the Active Depth).

**Note:** You may also right-click on an ACS in the ACS dialog and select Set Active View.

**Turn the ACS Plane on or off**

When the ACS Plane is disabled in the Locks Toolbar or Active Locks on the status bar the standard views (Top, Front, Right Side and Right Isometric) appear as shown here:
When the lock is on or enabled, the ACS becomes the top view and all other views rotate accordingly.
Selecting planes by picking a face

The Define ACS (by Face) tool in the Auxiliary Coordinate dialog. When you select a face, a new object named Widget appears. This object is used to flip, rotate, and move the origin of the new ACS you are creating.

The objective of the following exercise is to draw a 5-sided regular polygon on the angled faces of a pyramid using the Define ACS (By Face) tool.

Exercise: How to use the new Define ACS By Face tool

1. Open 3Dintro.dgn and open the model 06-AccuDraw Face tool.

You see a Right Isometric view of a pyramid with many angled faces.

Note: The active planes is ACS(0,0,0) but when you select a new face and the AccuDraw compass aligns with this face, then ACS(0,0,0) is no longer the active ACS for that view.
2 Select the Define ACS (By Face) tool from the Auxiliary Coordinate dialog.

3 Enter a data point on the face indicated by Plane 1. You can also double click the face.

**Hint:** To select a face behind a face, on first click on face, move widget to and edge then when you right click, the other faces coincident with the selected edge, can be toggled.

4 At this point you can click on widgets (red and green lines with circles) to flip rotation of X or Y axis or click and drag a widget in the clockwise or
counter-clockwise direction to rotate the ACS. Another click will allow placement of a new origin for ACS.

5. enter a data point away from the ACS to accept the location.

At this point the ACS is unnamed.

6. Select, Create a New ACS to give it a name.

7. Select the Place Regular Polygon tool with the following tool settings:

   Method: Inscribed

   Edges: 5
Module Assessment

Assessment is often equated with evaluation, but the two concepts are different. Assessment is used to determine what an individual knows or can do. Complete the assessment to see what you have gained from reviewing this module.

AccuDraw in 3D Assessment
Module Overview

This module presents tools for creating Primitive Solid and Profile Solid models. When working with Solids it helps to think like a sculptor who starts out with a mass and cuts away what is not needed. Of course, in digital 3D you can add just as easily.

Module Prerequisites

- Knowledge about 3D view controls
- Knowledge about 2D drawing tools in MicroStation
- Knowledge about AccuDraw in 3D

Module Objectives

After completing this module, you will be able to:

- Use new 3D modification and creation workflows
- Use existing and new 3D Primitives
- Apply new features of existing tools
3D Workflows

All 3D modeling tools have a unified workflow that covers the way that you select items for creation and modification, and how you can modify them interactively.

For example, you can select edges and faces of solids and surfaces for modification with Element Selection. Typically, selecting edges, faces, or vertices, for solids and surfaces works as follows.

- Generally — select single items with a data point, and use Ctrl + data button for additional items.
- Faces — select the solid/surface first, and then dynamics let you select face(s).
- Back Faces — snap to an edge or vertex of a back face.
- Edges/Vertices — direct selection, or through dynamic selection.

Solids Modeling task

Contains basic Drawing tools plus 3D-specific tools for creating primitive solids, extrusions, revolutions, converting solids to surfaces and vice versa, and the Draw on Solid and Modify Solid Entity tools.

The first tool in the Solids Modeling task, Place SmartLine, is also a member of the Drawing task. When you press the left mouse button over the tool, you see a drop-down menu from which a tool in the Drawing task can be selected. The Drawing task can be opened as a floating toolbox by selecting Open As ToolBox from the drop-down menu.

When a tool is selected in the Drawing task, the tool automatically becomes the top icon of the child task in the Solids Modeling task.
3D Primitive Solids

Hint: Press F4 to see the current tasks at the pointer.

Alternate Display options exist for the Tasks dialog. Right click on the name of a task in the dialog itself or select from the icons beside the task name.

List option is useful when learning a new task and Panel option exposes all tools

Click here for a video overview of Primitive Solids

3D Primitive Solids

Many 3D solids can be created from one or more of the Primitive Solids models located in the Solids Modeling task. The primitive models available include the Slab, Pyramid, Sphere, Cylinder, Cone, Elliptical Cone, Ellipsoid, Torus, Wedge, and Polyhedron.

Note: 3D Surface Primitives are part of the Surface task.

Each tool setting has the Method, Axis, and parameters required to create the specific Primitive Solids.
3D Primitive Solids

- **Method**: Creation by Vertex, Edge, Face, Inscribe, Circumscribed, Center, Edge, or Diameter.

- **Axis**: Lets you choose how the axis for the element is defined. You can select from Points (AccuDraw), Screen X, Y, or Z, or Drawing X, Y, or Z. Screen is direction of the height is set to the screen's X, Y, or Z axis. Drawing is direction of the height is set to the drawing's, or model's, X, Y, or Z axis

Other settings are specific for each tool.

**Hint**: Although the primitives’ dimensions can be specified in the tool settings, for placing a single primitive it is generally quicker to type these distances into the AccuDraw window.

**Place Slab**

Probably the most useful of all primitives, the Place Slab tool can be used to draw any cubic object. Using this tool, you can construct a box shaped solid or surface. Element specific tool settings are as follows.

- **Axis**: Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z
- **Orthogonal**: When enabled, the sides are perpendicular to the base.
- **Length**: If on, specifies the length.
- **Width**: If on, specifies the width.
- **Height**: If on, specifies the height.

![Place Slab Diagram]

**Place Sphere**

With this tool, you can construct a sphere with two data points. Element specific tool settings are as follows.

- **Method**: Center, Edge, Diameter
• **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z
• **Radius:** When on, specifies the Radius.

---

**Place Cylinder**

A cylinder is defined by three data points; the center of its radius, then the radius, and finally the height. Element specific tool settings are as follows.

• **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z
• **Orthogonal:** If on, the center line of the cylinder is perpendicular to the base.
• **Radius:** If on, specifies the radius.
• **Height:** If on, specifies the height.

**Hint:** You can use the Modify Element tool to reposition the base or top of cylinders.

---

**Place Cone**

Similar to the Place Cylinder tool, the Place Cone tool requires a fourth data point to define the Top radius of the cone. A cone with its apex cut off by a plane parallel to its base is called a truncated cone or frustum.

Element specific tool settings are as follows.

• **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z
• **Orthogonal:** If on, the center line of the cone is perpendicular to the base.
• **Top Radius:** If on, specifies the top radius.
• **Base Radius:** If on, specifies the base radius.
• **Height:** If on, specifies the height.
**Place Torus**

A torus is a round doughnut-shaped object that is defined by four data points; the start point, the center point, the sweep angle, and the secondary radius. The primary radius is the one the torus is swept around and is the distance between the start point and the center point. The secondary radius defines the inner radius, or the radius of the torus’ circular section.

![Torus Image]

Element specific tool settings are as follows.

- **Axis**: Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z
- **Primary Radius**: If on, specifies the primary radius.
- **Secondary Radius**: If on, specifies the secondary radius.
- **Angle**: If on, specifies the sweep angle.

**Place Wedge**

A wedge is constructed by revolving a rectangular section about an axis. It is defined by four data points. The first data point defines a corner of the wedge, the second data point defines the center point of the wedge and the point to rotate about, the third data point defines the sweep angle and the fourth data point defines the height of the wedge.

![Wedge Image]

Element specific tool settings are as follows.
### 3D Primitive Solids

- **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z.
- **Triangular:** Determines the shape of the wedge. If on, the outer face is flat (a chord of the swept surface). If off, the outer face is rounded.
- **Radius:** If on, specifies the radius.
- **Angle:** If on, specifies the angle.
- **Height:** If on, specifies the height.

### Place Pyramid Solid

A multi-sided pyramid with equal sides or a rectangular pyramid can be created with this new primitive solid.

- **Method:** Inscribed, Circumscribes, By Edge, and Rectangle.
- **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z.
- **Orthogonal:** When enabled, the sides are perpendicular to the base.
- **Edges:** You can create from 3 to 63 edges.

The image on left shows Inscribed, Circumscribed, By Edge method and image on right shows Rectangle method

➔ **Exercise: Draw a pyramid solid**

1. Open Basic_Solids.dgn and open the model 01_3D Primitives.
3 Select Pyramid Solid with the following tool settings:

- **Method:** Inscribed
- **Axis:** Points (AccuDraw)
- **Edges:** 5
- **Orthogonal:** Enabled

4 **Enter Center Point:** Click anywhere in view and set AccuDraw rotation to (T).

- **Define base radius:** Move cursor 40 units in positive X direction.
- **Define height:** Move cursor 80 units in positive Z direction.
- **Define top radius:** Move cursor 20 units in positive X direction.

When Orthogonal is disabled, you can create skewed Pyramid Solids, where the sides and height are not restricted to being perpendicular to base radius.

When all settings are enabled, you merely define the direction of each dimension. This is useful when you want to place a number of Pyramid Solids with the same dimension values. If they are all identical, the Copy tool can be used after placing the first slab.

**Elliptical Cone Solid**

This tool is used to place an elliptical cone solid, which is a transition solid between two ellipses. The resulting solid is a SmartSolid. Tool settings are as follows.

- **Axis:** Points (AccuDraw), Screen X, Y, Z, Drawing X, Y, Z.
- **Orthogonal:** If on, the element is a right elliptical cone.
- **Base Primary Radius:** If on, sets the primary axis radius for the base.
- **Base Secondary Radius:** If on, sets the secondary axis radius for the base.
- **Height:** If on, sets the height of the elliptical cone.
• *Top Primary Radius*: If on, sets the primary axis radius for the top.
• *Top Secondary Radius*: If on, sets the secondary axis radius for the top.

→ **Exercise: Draw an elliptical cone solid using AccuDraw**

1. Continuing in Basic_Solids.dgn, in the 01_3D Primitives model, with the Solids Modeling task active in the Tasks dialog, select Elliptical Cone Solid with the following tool setting:
   
   *Axis*: Points (AccuDraw)
   
   *Orthogonal*: Enabled

2. Enter a data point anywhere in view and set AccuDraw rotation to (T). Enter the base ellipse center point.

3. Enter a primary radius (x-axis = 20) and a secondary radius (y-axis = 40) to create the elliptical base.

4. Enter (z-axis = 80) to define the height of the Elliptical Cone Solid. AccuDraw automatically switches to the correct AccuDraw Plane rotation in order to enter the height.

5. For the top ellipse enter a primary radius (x-axis = 40), secondary radius (y-axis = 20) and final data point to complete the solid primitive.

   ![Elliptical Cone Solid](image)

**Ellipsoid Solid**

This tool is used to place an ellipsoid, a solid defined by three radii. An ellipsoid is a type of quadric surface that is a higher dimensional analogue of an ellipse.

→ **Exercise: Draw an Ellipsoid Primitive Solid using AccuDraw**

1. Continuing in Basic_Solids.dgn, in the 01_3D Primitives model, with the Solids Modeling task active in the Tasks dialog, select Ellipsoid Primitive Solid with the following tool setting:

   *Axis*: Points (AccuDraw)
Orthogonal: Enabled

2 Enter a data point anywhere in the view and set AccuDraw rotation to (T). Enter the base ellipse primary radius (x-axis = 40).

3 Enter a secondary radius (y-axis = 20) to create the elliptical base.

4 Enter a tertiary radius (z-axis = 20) to complete the Ellipsoid primitive solid.

AccuDraw automatically switches to the correct AccuDraw Plane rotation in order to enter the tertiary radius.

Regular Polyhedron

A polyhedron (plural polyhedra or polyhedrons) is often defined as a geometric object with flat faces and straight edges of equal length.

Method:

- Vertex — Radius is measured from the center of the polyhedron to each vertex.
- Edge — Radius is measured from the center of the polyhedron to the midpoint of each edge.
- Face — Radius is measured from the center of the polyhedron to the center of each face.

Radius: If on, defines the Radius used to construct the polyhedron.

Face Number: Option menu that lets you select the number of faces for the polyhedron — 4, 6, 8, 12, or 20.
Exercise: Draw an Polyhedron Primitive Solid using AccuDraw

1. Continuing in Basic_Solids.dgn, in the 01_3D Primitives model, with the Solids Modeling task active in the Tasks dialog, select Polyhedron Primitive Solid with the following tool setting:
   
   Method: Vertex
   
   Axis: Points (AccuDraw)
   
   Face Number: 20

2. Enter a data point anywhere in view, set the AccuDraw rotation to (T), and then define the radius and axis for the Polyhedron primitive.

Create Solids Toolbox

The Create Solids tools include Solid by Extrusion, Solid by Revolution, Solid by Extrusion Along, Solid by Thicken Surface and Linear Solid.

If you need to create complex or curved solids, you can often create them from a profile element. You can extrude a profile in a straight line, along a specific 3D path with profile rotation control.

Click here to see a video overview of the Create Solids tools
Solid by Extrusion

This tool is used to construct 3D solids from 2D profiles. It lets you extrude, or project, a planar 2D element along an axis to create a 3D object. Thus, lines become planes, circles become cylinders and blocks become slabs. When complex shapes or SmartLines are used as the profiles, quite complex solids are possible. There is an equivalent tool in the Surface Modeling task. Available element types for extrusion are:

- Line
- Line string
- Arc
- Ellipse
- Shape
- Text
- Multi-line
- Complex chain
- Complex shape
- B-spline curve

Surfaces formed between the original profile element and its extrusion are indicated by straight lines connecting the keypoints.

Tool settings are as follows.

- **Orthogonal:** When on, the sides are perpendicular to the plane of the profile element.
- **Distance:** When on, defines the distance of the projected extrusion.
- **Both Directions:** When on, the extrusion is constructed in both directions from the profile.
- **X Scale and Y Scale:** When on, specifies the scaling factor for the shape as it is being projected. Scaling is uniform about the point at which the shape is identified.
- **Spin Angle:** When on, defines the angle through which the 2D element rotates (counter-clockwise) about the axis of projection (maximum 360°). To correctly specify the rotation, you must select the shape at the point about which the rotation is to occur.
Hint: When using Spin Angle it is best to select the center of the profile as the pivot point.

- **Use Active Attributes:** When on, the surface or solid of revolution is created with the element using the active attributes. When off, the surface or solid of revolution is created with the element taking the attributes of the profile element.
- **Keep Original:** When on, the original profile element is kept. When off, the profile is deleted.

➤ **Exercise: Extruding a profile**

1. Open Basic_Solids.dgn.
2. Open the model 02_Extrude 1.
   The model is part of an observation platform. Profiles for the support columns are ready to be extruded.
3. Select Solid by Extrusion, with the following tool settings:
   - **Orthogonal:** Enabled
   - **Distance:** Enabled and set to 3.0
   - **All other options:** Disabled
4. Following the status bar prompt, in the Isometric view, identify profile in the lower left.
5. Move the pointer above the profile so the extrusion is upward, and accept with a data point.

You can extrude multiple profiles, in a single operation, by first selecting the profiles with the Element Selection tool.

➤ **Exercise: Extruding multiple profiles**

1. Continuing Basic_solids.dgn, in the model 02_Extrude 1, select Element Selection from the Main toolbox with mode set to Block and method set to Add.
2. In the Isometric view, draw a block around the remaining three column profiles.
3. Select Solid by Extrusion, with the following tool settings:
Create Solids Toolbox

Orthogonal: Enabled
Distance: 3.00
All other settings: Disabled

4 Enter a data point to accept the selection set.

5 Move the pointer above the profiles so that the extrusion is upwards, snap to accept this direction.

Extrusions may have a scale applied to them, a spin angle applied, or both.

⇒ Exercise: Extruding with Spin Angle and Scaling

1 Continuing in Basic_Solids.dgn, open the model 03_Extrude 2.

2 Select Solid by Extrusion, with the following tool settings:

   Orthogonal: Enabled
   Distance: Enabled and set to 8
   Spin Angle: Enabled and set to 45
   All other settings: Disabled

3 In the Isometric view, snap to the center of the left profile.
4 Move the pointer upward and accept with a data point.

5 Change the following tool settings:
   
   * **Spin Angle**: Disabled
   * **X Scale**: Enabled and set to 0.75
   * **Y Scale**: Enabled and set to 0.75

6 Identify the center of the center profile.
7 Move the pointer upward to extrude in that direction and accept with a
data point.

8 Enable Spin Angle and set it to 45.

9 Identify the center of the right profile and extrude it upward.

With Orthogonal enabled, all extrusions are perpendicular to the plane of the
element being extruded. The position of the pointer merely defines whether the
projection is up or down from the profile. If you disabled Orthogonal, you can
define the extrusion to be in any direction.

**Solid By Revolution**

When you require a curved circular extrusion, you can use the Construct
Revolution tool. As with the Extrude tool, this tool also is used to construct 3D
solids or surfaces from 2D profiles. In effect, a profile is revolved about an axis to
create a solid or surface. Available element types for curved circular extrusion are:

- Line
- Line string
Tool settings for this tool are as follows.

- **Axis**: Defines the direction of the axis about which the revolution is performed. Options are: Points (AccuDraw); Screen X, Y, or Z; Drawing X, Y, or Z.

- **Angle**: Defines the sweep angle of the revolution (about the axis).

- **Use Active Attributes**: When on, the surface or solid of revolution is created with the element using the active attributes. When off, the surface or solid of revolution is created with the element taking the attributes of the profile element.

- **Keep Original**: When on, the original profile element is kept. When off, the profile is deleted.

In the next exercise, you will rotate a profile of a rocket nozzle 360 degrees around an axis to create a solid.

**Exercise: Create a solid by revolving a profile**

1. Continuing in Basic_Solids.dgn, open the model 04_Revolution 1.
2. Select Solid by Revolution with the following tool settings:
   - **Axis**: Points (AccuDraw)
   - **Angle**: 360
   - **Other settings**: Disabled
3. In the Isometric view, identify the profile.
4 Snap to the top of the dash-dot line at and accept with a data point.

The proposed solid is displayed. Note that the pointer now controls the axis of the revolution. As you move it, the radius changes and the solid changes in size. You can change the axis plane using AccuDraw shortcuts.

The pointer controls the location of the axis.
5 Snap to the bottom of the dash-dot line at and accept with a data point.

The solid is completed.

6 In View 4, click the View Display Mode view control and change the display mode to Smooth.

You can turn off the level Default to remove the center line.

7 Select File > Close.

Using the Construct Revolution tool, you can create complex curved 3D solids from a 2D shape or complex shape. Equally, you can revolve an open element, such as a line string or an arc to create a curved surface.

**Solid By Thicken Surface**

This tool is used to add thickness to an existing surface to create a solid, by thickening it in the direction of the surface normals. Upon identifying the surface, an arrow displays showing the distance and direction of the thickening that will be added. If Add To Both Sides is on, arrows display in both directions. If Thickness is not turned on, then thickening is added graphically, with the amount of thickening defined by the screen pointer. Tool settings are:

- *Add To Both Sides*: If on, the thickness value is added to both sides of the surface.
- *Thickness*: If on, sets the thickness value that is added to the surface.
- *Face Only*: If on, lets you select an individual face of a solid or surface.
• **Full Dynamics:** If on, displays a preview. On large surfaces, the display may take a long time. Turning the toggle off will reduce the generation time.
• **Keep Original:** If on, the original profile element is retained.

цы Solid by Thicken Surface:

1. Select the Solid by Thicken Surface tool.
2. Turn on Thickness.
3. In the Thickness field, enter the value for the thickening.
4. If necessary, turn on Add To Both Sides.
5. Identify the surface.
6. The surface highlights. An arrow(s) displays, showing the distance and to which side(s) the thickness will be added.
7. If Add To Both Sides is off, move the pointer, using the arrows as a guide, to select the side for thickening.
8. Accept.

Linear Solid

This tool is used to create a wall like solid (with rectangular section) by defining its alignment direction.

цы Exercise: Create a linear solid

1. Continuing in Basic_Solids.dgn, open the model 05_Linear Solid.
3. Select Linear Solid with the following tool settings:
   
   *Place by:* Center
Width: 0.5

Height: 3

4 Enter a data point in any view and draw the floor plan as dimensioned in the following image.
Challenge Exercises

→ Exercise: Draw a door and hardware

1. Create a new model in AccuDraw_3D.dgn. Set working units set to “m” (MU) and “cm” (SU) and work only in the Isometric view.

2. Use the Place Slab tool to create the solid door, 2.5m tall, 5cm thick and 75cm wide (Front orientation).

3. Place 2.5cm diameter cylinders for the hinges (7.5cm long starting 15cm from the top and bottom) with the center of the hinge on the edge of the door.

4. Use the Place Sphere and Place Cylinder tools to create the doorknob (5cm diameter spheres on both sides with a 2.5cm diameter cylinder, 15cm long, connecting them). Place the doorknob assembly 5cm from the edge of the midpoint of the door.

→ Exercise: Draw a floor lamp

The lip around the shade is a torus with a primary radius of 30cm and secondary radius of 2.5cm. It is placed from an edge of the shade.

The Shade is a surface Cone with a Base radius of 5cm, height of 22.5cm and Top radius of 30cm.

The Pole is a Cylinder that is 195cm high and 5cm in diameter.

The Base is Cylinder with a radius of 22.5cm and height of 5cm.
3D Modeling Process

Up to this point you have learned the basics for creating primitive solids and solids from profile shapes. In the next topic you will see some basic modification techniques for combining models to create a new model.

The following chart gives you an overview of the 3D modeling process. (Surface and Feature modeling is not covered in this introductory course.)
Modifying Solids

There are numerous tools for Solids modification. This course will address the Solid Unite, Subtract, intersect and Cut tools. Sometimes these operations are called boolean operations. All the modification tools are located in the Solids Modeling Task.

Uniting Solids

Uniting Solid models is defined as combining two or more Solid models. For example, the following is uniting a primitive slab and a cylinder.

Note: The element color of the first selected model becomes the color of the united model.

Intersect Solids

Uniting Solid models is defined as combining two or more Solid models. For example, the following is uniting a primitive slab and a cylinder.
**Note:** The element color of the first selected model becomes the color of the united model.

Left image before intersecting models, middle Slab was selected first and right image cylinder selected first

➔ **How to use Intersect Solids:**

1. Begin with at least 2 Solids.

2. Use the Intersect Solids tool

3. Select Solid 1 then Solid 2 or Ctrl+data for more solid models.

4. Here is the Resultant intersected model.


Modifying Solids

Model takes on color of first model selected

⇒ Extra credit exercise:

1. Open IntersectSolid_example in Basic_Solids.dgn and try this example.

Subtract Solids

Uniting Solid models is defined as combining two or more Solid models. For example, the following is uniting a primitive slab and a cylinder.

Note: The element color of the first selected model becomes the color of the united model.

Left image before uniting models, middle Slab was selected first and right image cylinder selected first
Cut Solids By Curves

Solid models can be cut with a line, curve, shape or surface. The following model will be cut with a curve, a shape and a surface.

> How to cut solids:

1. To cut a solid with a line, you first select the solid, on an area that you want to keep, then select the line and make sure the cut is going through the model, (Forward or Back), by viewing the green arrow that appears.

2. To cut a solid with a shape follow the same procedure as step 1.

3. To cut a solid with a surface follow the same procedure as step 1.

Click here for a video review of the Cut Solids tool using the Cut_solid_by_curve model in Basic_Solids.dgn
**Exercise: Basic solids final challenge**

In this exercise you will create a 3D model using any of the tools presented in this module. There are numerous ways to create a finished model and no one way is the correct way. The important thing to remember is how efficiently and productively you create the finished product.

1. Open solids_final_challenge in Basic_Solids.dgn

2. Here is an image of the Final Challenge model. Exact size is not important but try to maintain the same proportion so that you capture the conceptual design intent.
Module Assessment

Assessment is often equated with evaluation, but the two concepts are different. Assessment is used to determine what an individual knows or can do. Complete the assessment to see what you have gained from reviewing this module.

Basic Solids Assessment
Conceptual Modeling

Module Overview

Push-pull modeling or conceptual modeling technology lets you quickly create and modify solids interactively, by adding or removing faces, edges, and vertices and pushing and pulling faces, edges, and vertices.

Module Prerequisites

- Knowledge about AccuDraw in 3D
- Knowledge about basic solid modeling

Module Objectives

After completing this module, you will be able to:

- Use the Draw on Solid tool
- Use the Modify Solid Entity tool
- Use the Delete Solid Entity tool

Conceptual Modeling Tools

This section introduces you to the conceptual modeling tools.
Draw on Solid

The Draw on Solid tool is in the 3D Modify toolbox. It lets you draw lines, shapes, and circles, directly onto the face of an existing solid, or you can imprint a curve onto the face. These additions become faces that can be modified with the Modify Solid Entity tool, which lets you push and pull on faces and vertices.

The tool recognizes the nearest face under the pointer and matches the AccuDraw drawing plane to the selected face.

**Note:** If a drawn line does not intersect with an existing edge, it is extended or trimmed back to the edge.

Draw on Solid is used to create an edge on a solid by drawing the following onto the face of a solid:

- Line
- Line string
- Block
- Circle
- Shape
• or imprinting a Curve

The solid, including the newly created edges, vertices and faces can be modified with the Modify Solid Entity tool, or deleted with the Delete Entity tool.

For the Imprint Curves option, you can select a face located behind another by entering one or more resets, or using a different view.

The Offset option lets you draw lines offset from edges of the face of a solid. These edges can include edges previously drawn on the face of the solid.

• Loop — Selects all edges surrounding the identification point on the face of the solid.

• Edges — Lets you select one or more edges on a face of a solid. Use <Ctrl> + Data points to select additional edges.
Conceptual Modeling Tools

⇒ Exercise: Quick test of Draw On and Modify Solid

1. In a new file, try creating the solids in the preceding images.
2. Use Place Slab, and then Draw On Solid.
3. Then, use Modify Solid to adjust the solid.

Modify Solid Entity

The Modify Solid Entity tool is in the Solids Modeling task. It is used to manipulate a face, edge, or a vertex of a solid by pushing or pulling it interactively.

Icons in the tool settings let you select All, a Face, an Edge, or a Vertex when you are selecting the item to modify. These options determine what you modify, and how the entity is selected.

Tool settings are as follows.

- All: Lets you select a visible face, or any edge or vertex on a solid in the view.
- Face: Lets you select a face on any identified solid in the view. By default the nearest face is selected, with resets letting you select hidden faces on the same solid.
- Edge: Lets you select any edge on any solid in the view.
- Vertex: Lets you select any vertex on any solid in the view.
- Distance: If on, sets the distance that the face, edge, or vertex, is to be modified.
• Extrude Faces: If on, the selected face is extruded. If off, the selected face is moved and adjusted along with the adjacent sides.

• Full Dynamics: If on, dynamic display shows the modified element as you move the pointer. If off, an arrow graphic indicates the direction and extent of the modification.

Delete Solid Entity

This tool is in the 3D Modify toolbox. It is used to delete a solid entity from a solid other than a feature solid.

When selecting faces, the nearest face always is selected. You can rotate the view, or use another one, to select a hidden face. If need to delete multiple faces, you can select the additional faces with a Ctrl+data point.

Conceptual Modeling Basics

Conceptual modeling tools let you interactively push-pull solids to modify their faces, edges, or vertices. This lets you quickly create and modify solids interactively.

Drawing lines on a Solid face

Figure 1. line drawn on face
In Figure 1, a line was drawn from the midpoint of the solid’s left edge to the midpoint of the right edge, using the Draw on Solid tool with the Draw Line option enabled.

In Figure 2, the line, which is now an edge, has been pulled in the Z-axis using the Modify Solid Entity tool.

The following images show the process of creating the final design concept using the previous tools.
Projecting lines on a Solid face

Basic MicroStation elements such as lines, shapes and B-spline curves can be projected on to Solid faces. These elements become edges after projection. These edges can be modified by extruding a face and moving an edge or vertex.
### Draw on Solid

The Draw on Solid tool is works with AccuDraw dynamics for the Draw Line, Draw Block, and Draw Circle modes. It eliminates the need for preliminary AccuDraw orientations prior to activating the tool.

### Keep Original Option for Imprinted Curve

The Imprint Curves mode now lets you retain the original imprint curve by activating a Keep Original option.

### Offset Edge Beyond Face

The Offset Edges mode now lets you draw off the solid. Locate edges inward (towards the solid) or outward (away from solid) by moving the AccuDraw Compass in one of those directions.

*Left*: Edges are offset inward when AccuDraw points towards the inside the selected edge.

*Right*: Edges are offset outward when AccuDraw points towards the outside the selected edge.

Lines offset away from the solid may be used for extruding additional solids. Any extrusion made from these offsets is not part of the original solid, but may be used in a Boolean operation to unite the two solids.

### Multi-select Improvements for Modify Solid Entity tools

The Modify Solid Entity tool lets you select multiple faces, edges, or vertices on a single solid by using the Face, Edge, and Vertex icons.

Pressing and holding the <Ctrl> key lets you select and deselect multiple entities. Clicking Reset changes the selections by replacing entities with adjacent ones.

AccuDraw reorients intuitively as entities are selected. The Face, Edge, and Vertex icons respond as follows:
**Face**

AccuDraw orients the drawing plane perpendicular to the last selected face so the Y and Z axes are coplanar (to the face), and the push-pull is along the X axis.

**Edge**

AccuDraw orients the drawing plane perpendicular to the last edge selected.

**Vertex**

Because a vertex is a point, AccuDraw has no reference plane to reorient itself to. Instead, AccuDraw orients the drawing plane to the last used orientation.
Create a Conceptual Design

The Vertex icon differs from other multiple selections in how vertices are detected. For instance, if an edge is selected near its midpoint, both its vertices are highlighted. If only one is needed, then moving the pointer nearer to it causes the other to not be highlighted. If both are highlighted and selected, either may be deselected by pressing the <Ctrl> key.

Multiple selection works only with entities of a single solid. Results may vary depending upon the complexity of the resultant solids. Automatic AccuDraw orientations may need to be manually reoriented to achieve the desired geometry. The All icon does not support multiple selections. Use the Face, Edge, or Vertex icons.

Click here for a video review of Draw on Solid and Modify Solid Entity

Create a Conceptual Design

The object of this exercise is to create the following model using Push - Pull modeling techniques.
Exercise: Create the model shown in the image

1. Open the model Design Concept in Conceptual Modeling.dgn.
2. Turn on the Level designconcept_steps.
3. Select the Solids Modeling task.
4. Select Draw on Solid, read the prompt, and in the tool settings select:
   Imprint Curves: Enabled
5. Imprint both the Octagonal shapes onto the base solid.
   Remember to select the Solid face onto which the curves are to be imprinted.
6. Using Modify Solid Entity, read the prompt and select the inner shape and extrude up by 0.5 meters.
   This will create the third step of the base. Now you will create the second step.
7. Using Modify Solid Entity, read the prompt and select the face of outer imprinted shape and extrude that face 0.25 meters.
   This will create the second step in the design.
8. Turn on the Level designconcept_columns.
9 Select Draw on Solid and the Imprint Curves tool setting and imprint each of the columns onto the face of the base solid model.

10 Select Modify Solid Entity, enable the Select Face option, and extrude face of each imprinted column a distance of 10 meters.

**Hint:** To save time, turn on the Level designconcept_roof to display the a second completed model of the roof for this design.
This model used Draw Line on Solid and the Modify Solid Entity Vertex option to create the roof shape.

11 Use the Construct Union Tool to unite both models into one Solid model.

⇒ Optional Exercise: Create the roof model
   1 Create the octagonal shape.
   2 Extrude the shape 0.5 meter.
   3 Draw lines on the solid.
4 Use Move Vertex to create roof.

Advanced Optional Exercise: Create the Pyramid model

1 Open the Pyramid model in Conceptual Modeling.dgn file.

To give you a head start, a Primitive Solid Pyramid displays and already has lines imposed on the solid.
The following image contains some visualization effects that you can learn if you take the Visualization course. The pyramid model was created using the Draw On Solid tools.
Module Assessment

Assessment is often equated with evaluation, but the two concepts are different. Assessment is used to determine what an individual knows or can do. Complete the assessment to see what you have gained from reviewing this module.

Conceptual Modeling Assessment